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Please read this chapter carefully before using this product!

This chapter introduces the safety precautions before using this product. Please
make sure the content of this chapter is fully read and understood before installation
and usage. Our company will not undertake any responsibilities for any damage or
injury caused by improper operations because of ignoring relevant warning in this

operation instruction.

Before operating this device, relevant professional personnel shall read this

instruction carefully and well understand the content.
Operation instructions and warnings:
The following standard definitions will be adopted in this operation instruction.

Danger! Ignoring of safety precautions may cause personal death, serious personal
injury or serious equipment damage.
Warning! Ignoring of safety precautions may cause personal death, serious

personal injury or serious equipment damage.

Caution! Ignoring of safety precautions may cause a slight personal injury or
equipment damage, especially the damage of device or the equipment protected by

the device.
® Danger!

When the primary system is live working, secondary open circuit for the current
transformer connected to the device is absolutely forbidden, and the open of this

circuit may cause extremely dangerous high voltage.
® Warning!

Some parts of the device may have high voltage when the electrical device is running.

Improper operation may cause serious personal injury or equipment damage.

Only qualified professional personnel are allowed to operate the device or work
nearby the device. The operators professional shall well understand the precautions,

working flows and safety regulations mentioned in this instruction.



e Caution!
Grounding terminals of the device shall be firmly grounded.

The device is only permitted to run in atmospheric environment that specified in the
technical specifications, and abnormal vibrations shall be avoided in its running

environment.

When connect the AC voltage current circuit or power circuit, please make sure they

conform to the rated parameters of the device.

When the output terminals of the device are connected to external circuit, please

check carefully the voltage of external power to prevent overheating of the circuit.

Carefully check the cable connected to the device, preventing applying too much

external force on it.
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1.1 Description

With the development of the society, people has higher requirement on the power
supply reliability. Many occasions to ensure the reliability of power supply with two
way power supply, which requires a product in reliable switching between two power
supplies, our company produces the intelligent dual power automatic switching
device is mainly composed of two sets of circuit breaker and a dual power supply
capacity for self controller in two parts. Applied to ac 50HZ, rated voltage of 12 KV,
rated current 1250A dual power supply system, when the power failure or under
voltage occurred in power source automatic switch all the way to the other along the
normal power supply, reliable guarantee for the continuity of power supply

The controller has a short circuit, a three-stage over-current, single phase grounding,
under voltage, reclosing and prepaid and various protective functions, effectively
avoid the unnecessary power supply shock again when load failure. In common
power failure occurs, switching device can complete with standby power automatic
switch, to ensure the reliability and security. Particularly applicable to not allow the
important place of power, as an important electrical control device to ensure
continuous power supply, is with circuit breaker of the replica dual power automatic
switch device. Products are widely used in oil fields, mines, 10 KV distribution line,
industrial and mining enterprises, 10 KV line, ensure that important real-time power
supply load, less space, small investment, debugging, maintenance is convenient
wait for a characteristic, is the realization of the ideal switch of the power supply
automation equipment.

The controller is an automatic management unit for single way/multi ways/ring
network/two power sourcing, provided with all voltage and current signals and all
functions.

RWK-LC column switch intelligent controller supports:

Wireless (GSM/GPRS/CDMA), Ethernet mode, WIFI, optical fiber, power line carrier,
RS232/485, RJ45 and other forms of communication, and can access other station
premises equipment (such as TTU, FTU, DTU, etc.).

1.2 Product mode definition



1.3 Protection

49 Thermal Overload (Over load)

50 Instantaneous Overcurrent (Ph.OC)
50G/N/SEF  Instantaneous Sensitive Earth Fault (SEF)
27/59 Under/Qver Voltage (Ph.OV/Ph.UV)

51c Cold load pickup (Cold load)

1.4 Supervision

60CTS CT Supervision
60VTS VT Supervision
1.5 Control
79 Auto Reclose
86 Lockout

CB Control

1.6 Features
Password Protection — 2 levels.

50Hz systems and two phase/three phase wiring method are available, so that the
use scope of device is extended.

Protection configuration is complete, and all protection functions can be switched on
and off flexibly.

4-way intellectual switching value input.

Large capacity flash memory can record at least 100 times of historical events, and
no data will loss even the power is off.

Circuits operating loop can be used both the direct or alternating current, self-
adaptation open/close brake function, which can co-work with various of breakers,
and the operation is simple and reliable.

The device has complete self-inspection function to in-service monitor the working
conditions of various parts of the device, ensuring the reliability of the device.



1.7 Monitoring Functions

Primary Currents Phases and Earth Direction
Secondary PT Voltage

Frequency

Binary Input/Output status

Trip circuit healthy/failure

Time and date

Fault records

Event records

1.8 Hardware

8CT 2 VT 6Binary Inputs 4 Binary Outputs
1.9 Data Storage and Communication
RS485/USB or RS485/RS232 port

Protocols —IEC60870-5-101, IEC60870-5-104, DNP3.0 or Modbus RTU
Event Records

Fault Records

Measurands

Commands

Time Synchronism

Viewing and Changing Settings



Chapter 2: Technical Performance Index

2.1 Inputs and Outputs
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Auxiliary Supply

Binary Inputs

2.3 Serial Interface




2.4 Data Storage

2.5 Mechanical Tests

Vibration (Sinusoidal) --- IEC 60255-21-1 Class I

Shock and Bump --- IEC 60255-21-2 Class 1

Shock and Bump --- IEC 60255-21- 3 Class 1

Mechanical Classification

2.6 Electrical Tests

Insulation --- IEC 60255-5
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Type Level

Between any terminal and earth 2.0 kV AC RMS for 1 min
Between independent circuits 2.0 kV AC RMS for 1 min
Across normally open contacts kV AC RMS for 1 min

High Frequency Disturbance --- IEC 60255-22-1 Class III

Type Level Variation
Common (longitudinal) mode 2.5 kv <5%
Series (transverse) mode 1.0 kV <5%

High Frequency Disturbance --- IEC 60255-22-2 Class IV
Type Level Variation
Contact discharge 8.0 kv <5%

Fast Transients --- IEC 60255-22-4 Class A (2002)

Type Level Variation
5/50 ns 2.5 kHz repetitive 4 KV <5%
Surge Immunity --- IEC 60255-22-5

Type Level Variation
Analog Inputs: 4.0 kv <10%

Line to Earth

Case, Aux Power & I/O: Line to Earth 2.0 kV <10%
RS485 Comms port: Line to Earth 1.0 kv No Data Loss
Analog Inputs: 1.0 kV <10%

Line to Line

Case, Aux Power & I/0O: Line to Line 1.0 kv* <10%

* Note 45ms DTL pick-up delay applied to binary inputs

Conducted Radio Frequency Interference --- IEC 60255-22-6

Type Level Variation

11



Radiated Radio Frequency --- IEC 60255-25

Conducted Radio Frequency

Radiated Immunity --- IEC 60255-22-3 Class III

2.7 Climatic Tests
Temperature --- IEC 60068-2-1/2

Humidity --- IEC 60068-2-78

Chapter 3: Protection Functionality

3.1 Function Description
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Double protection
Locking condition: CT1 or CT2 over-current, remote or manual open the switch.
Non priority (mode 0)

No priority for the cast refers to both sides in line as spare power supply, power
supply of reciprocity. When one side line power supply after losing electricity the
other side active investment, bilateral power supply for each other. For example, PT1
and PT2 have power, DL1 switch in on position, DL2 switch in off position at the
beginning. When losing electricity into the line 1, PT1 from pressure to no pressure,
then the controller after a delay will break-brake DL1 switch first, after closing DL2
switch, switch to the power supply into line 2. When power supply into line 1 is
missing, PT1 from has the power to no power supply, then the controller after a
delay time will opening DL1 switch first, after closing DL2 switch, switch to the power
supply into line 2. As shown in the figure below.

Linel LineZ2 Linel Line?Z2
L1 § oo nr1 f§ oo
PT1 I I PT2 PT1 I I PT?2
 — iee—————=
Load Load
Have priority

A priority is to point to distinguish DL1 and DL2 switch priority, mode 1: DL1 switch
of high priority, mode 2: DL2 switch of high priority. For example, set the switch
priority to DL1, when the power outage of DL1 side automatically switch to the low
priority of DL2 switch, but the switch this side of the high priority to restore power,
the controller will switch the power back in the power of the high priority, restore the
initial state.

Double protection logic diagram:

| Line 1 loss power |

I Line 1 no over current

| LLine 1 in on position

&r-—{WhF——{Lmrlnnj F—{[MW2vhmv

1]

{ Line 2 in off position

;

| Voltage into line 2 is normal

| Double is run I

Note: Runis™ v ", Stopis“X".
Tb—Delay time
Operation logic diagram:

(1) Electric closing operation: Through the controller panel or remote closing
operation.

13



Line 1 in on position —

Voltage into line 1 is normal

& Line 2 closing is invalid

Line 2 manual close

Line 2 remote close

(2) Mechanical closing operation: Not through the controller, direct closing on
the switching mechanism.

(3) Opening operation

Line 1in on position

Line 2 in off position
& -
. — & Auto close is locked
Voltage into line 2 is normal
Line 1 manual trip
Line 1 remote trip =1
Line 1 mechanical trip

Note: The above case since the logic to satisfy the following.

1.
2.

3.

vk

Busbar voltage disappears double will start;

Standby power is in the judgment to the working power supply accurate
after input separately.

Due to the fault current will blocking dual power supply, not for expanding
the scope of the fault

Standby power determine after input voltage.

Standby power investment of time can be on the scene through the
parameter setting, setting value continuously adjustable.

14



51c Cold Load Pickup (Cold Load)

If a circuit breaker is closed onto a “cold” load, i.e.one that has not been powered
for a prolonged period, this can impose a higher than normal load-current demand
on the system which could exceed normal settings. These conditions can exist for an
extended period and must not be interpreted as a fault. To allow optimum setting
levels to be applied for normal operation, the cold load pickup feature will apply
alternative current settings for a limited period. The feature resets when either the
circuit breaker has been closed for a settable period, or if the current has reduced
beneath a set level for a user set period.

Action Logic diagram:

Note: Runis™ v ", Stopis™X".
I'set—Cold load pickup current Iset—Ph.OC pickup current T—Delay time

50/51/51V/67 Phase Fault (Ph.OC)

Three sections phase overcurrent protection for lines include Ph.OC1 (instantaneous
overcurrent protection), Ph.OC2 (definite time overcurrent protection) and Ph.OC3
(overcurrent protection). All of which are definite time actuate features.

Action Logic diagram:

Note: Runis™ v ", Stopis™X".
IA IB IC—Measured current Iset—Pickup current T—Delay time
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50G/51G/50N/51N Sensitive Earth Fault (SEF)
The sensitive earth fault protection is definite time limit.

Action Logic diagram:

Note: Runis™ v ", Stopis™Xx".
3I0—SEF current 10set—Pickup current T—Delay time

79 Auto - Reclose (Reclose)

A high proportion of faults on an overhead line network are transient and can be
cleared quickly by high speed tripping followed by an automated circuit breaker
reclose sequence.

The function provides phase fault and earth fault/sensitive earth fault sequences of
up to 5 trip i.e.4 reclose attempts before lockout, and the charging period of the
reclose is 10 seconds.

Action Logic diagram:

Ph.0OC Trip

[ Reclose is Run

Reclose count #0 |

Reclose unlock

Manual trip

|
]
|
Remote trip } g
]
|

After close =108

Note: Runis™ v ", Stopis™Xx".
Reclosing acceleration (Recl.ACC)

When switching on reclosing acceleration, if accidents happened in 3S after the
reclose is operated, the phase over current protection will accelerate the operation.
Action Logic diagram:

IA>]set

After reclose 2385

Recl.ACC is Run

Note: Runis™ v ", Stopis“X".
IA IB IC—Measured current Iset—Pickup current T—Delay time
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Manual closing acceleration (Manu.ACC)

When switching on manual closing acceleration, if accidents happened in the exit
time after operated the close, the phase over current protection will accelerate the
operation. The exit time of acceleration can be adjusted.

Action Logic diagram:

[A>Iset —‘
IB>Iset 1

IC>1set J

| Manual/Remote Close |7& T Tri
- - 1 1 T1D
| After close <Exit time }7

| Manu.ACC is Run I

Note: Runis™ v ", Stopis™Xx".
IA IB IC—Measured current Iset—Pickup current T—Delay time

Under/Over frequency (Frequency)

Frequency protection with slip lock, low voltage lock.
Action Logic diagram:

| Low volt. lock mode (1)

[ UA>Uset } L

o 1
| Slip lock mode (1) | 9 &

5 Trip

| Febset / B2 Esat I
| Frequency is run I

Note: Runis™ v ", Stopis™X".
UA—Secondary PT voltage Uset—Block low voltage constant value
dFset—Block slip constant value Fset—Low/High frequency constant value
F—Frequency T—Delay time

Prepaid (Optional features)

It is used to connect the dosing tank, the device will control the CB to trip when the
dosing tank is in deficit.
Action Logic diagram:

Note: Runis™ v ", Stopis™X".

17



3.2 Constant Value Parameters

All values are given primary side.
Double protection

Description Setting range Step length

0: Non priority 1: DL1 switch of high

Operating mode priority 2: DL2 switch of high priority

Double Low voltage 1~999.9 0.1v
Have voltage 10~999.9 0.1v
Delay time 0~9.99S 0.01S

51C Cold Load Pickup (Cold load)

Description Setting range Step length
Pickup current 1~6000A 0.1A
Coldload  helay time 0~99.995 0.01S

50/51/51V/67 Phase Fault (Ph.OC)

Description Setting range Step length
PH.OC1 Ei;';‘;p tfm”rerent é:g?fé\ 8:3)/;5
oy P Lomon
oy T Lomon

50G/N Sensitive Earth Fault (SEF)

Description Setting range Step length
SEF Pickup current 0.1~999.9A 0. 1A
Delay time 0~99.99S 0.01S
79 Auto - Reclose (Reclose)
Description Setting range Step length
Reclose count 0: Invalid 1:0One 2:Two 3:Three 4:Four
Reclose  Delay time 0~99.99S 0.01S
Reset time 1.2~180S 0.1S
Reclosing acceleration (Recl.ACC)
Description Setting range Step length
Pickup current 1~6000A 0.1A
REBEE e e 0~9.995 0.01S

Manual closing acceleration (Manu.ACC)

Description Setting range Step length
Exit time 0.1~9.99S 0.01S
Manu.ACC Pickup current 1~6000A 0.1A

18



81 Under/Over frequency (Frequency)

Prepaid (Optional features)

19



PT1e@ ®PT2
DL1 DL2

09:38:02
Inl: on
[a=0A
[c=0A =0A

Close1 Open Close2

The operator interface is designed to provide a user friendly method of controlling,
viewing menus, entering settings and retrieving data from the relay. 11 buttons are
provided for navigation around the menu structure.

4.1 LEDs

PT1® ®PT2
DL1 DL2

Load

Status of the circuit breaker and power PT

20



Operation Status

LED Categories

Name

Run

Comm.

Alarm

Closed
Opened

Action

Reclose
O.C.F
Earth.F

Lock

Color

Green

Green

Yellow

Red
Green

Red

Red
Red
Red

Red

ON

crash

No communication

Device failure or
protection alarm

Switch is on
Switch is off

Protective action

Reclose export
Over current alarm
Ground fault action

Reclosing lockout
alarm

21

Operation Status

LED Status
OFF

crash

No communication

Running normally

Switch is not on
Switch is not off

No protective
action

Normal
Normal
Normal

Normal

Flashing

Working
properly

Normal
communication



4.2 Keypad
The main keys

User actions are mainly concentrated on the operation panel.

‘.
ESC 4 »
& v
.

Key Function

+ Increase the number

- Reduce the number

t Move up or page up

| Move down or page down

- Move left

— Move right

ESC Return to the superior or Cancel the operation
Enter Enter the menu of confirm the operation

When you press the button, the buzzer of device will sing make a sound, so that
the operation is valid; if not, please do it again.
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Operation buttons

Key Function
Reset Touch reset button, you can reset protect information
Closel Touch closing button, close DL1 switch
Open Touch tripping button, trip switch
Close2 Touch closing button, close DL2 switch

When you press the button, the buzzer of device will make a sound, so that the
operation is valid; if not, please do it again.

Note: When you press the closing-button or tripping-button, you must make sure the
device is unlock; if the lockout-light is on, please press the reset-button to reset the
device, so that you can close or trip the switch.

4.3 LCD

A 4 line by 16 character liquid crystal display with power save operation indicates the
relay identifier, settings, instrumentation, fault data and control commands.

4.4 The Main Menu

Press “Enter” when on the main screen, as shown below, including “"EDIT” and
“VIEW” menu item. Select the corresponding menu item with the [<] key, [—] and
press "Enter" button to enter the corresponding sub-menu, press the “ESC” key to
return to the previous screen.

Primacy Menu
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4.5 Submenu
Edit submenu

Choose the edit options, the screen will enter the submenu of the Edit menu, as
shown below, the submenu includes "Relay”. “Para”. “Chnl”. “Clr”". “Time”.

“Comm”. “Fac”.

Submenu of edit

Enter “Relay” submenu, you can modify the protection
feature.

Enter “Para” submenu, you can modify or view other
parameters. Like communication address, baud rate,
password, trip and close pulse time.

Enter “Adj.” submenu, current and voltage values can be
corrected, press the function key "Enter" to be modified.

Enter “Clr.” submenu, you can clear out the trip report, the
alarm report, the SOE report, the count report and all
report.

Enter the “Time"” submenu will modify or check the time.

Enter “"Comm” Sub-menu, choose the way to
communication, it include “"GSM"and “GPRS".

Enter “Fac.” Sub-menu, modify and view the factory
settings.
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View submenu

Choose the view options, the screen will enter the submenu of the View menu, as
shown below, the sub-menu includes “Meter”, “RPT”, “Relay”, “Input”, “Ver”.

View submenu

Enter “Meter” submenu, you can view the primary side
measurement data include: PT voltage, phase current, zero
sequence current, frequency, phase angle.

Enter "RPT” submenu, you can view trip report, alarm report,
SOE report, count report.

Enter “Relay” submenu, you can view each protection feature
is invested and set up the parameters

Enter the “Input” submenu, you can view the input signal.
The input signal includes: Breaker close, Prepaid open,
Prepaid close, Spring ready.

Enter “Ver” submenu, you can view the product model, serial
number and date of manufacture.
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4.6 Entering the password interface

According to the above operation, before entering each item will first enter a
password input interface to prevent professional staff misuse. The device original
password is “0099”, as shown below, press [<] and [—] keys to switch, press the
[+] and [-] keys to increase and decrease the number of line with the correct
password press “Enter” button to enter.

Password interface

4.7 Relay setting

Select the “Relay” in the Edit submenu item, press the function key “Enter” to enter
the password screen, enter the correct password to enter the “Relay” submenu, as
Shown below, each item has a checkbox and set values.

1. Double: dual power supply

2. Ph.OC1: instantaneous overcurrent
Protection

3. Ph.0C2: definite time overcurrent protection
4. Ph.OC3: overcurrent protection

5. SEF: sensitive earth fault protection

6. Cold Load: cold load pickup

7. Reclose: OC/SEF reclose

8. Recl.ACC: reclosing acceleration protection
9. Manu.ACC: manual closing acceleration
protection

10. Frequency: frequency protection

11. Prepaid: debt protection

12. Power Alm: stored energy alarm
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Double

Select Double menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the operating mode (0: Non
priority 1: DL1 switch of high priority 2: DL2
switch of high priority).

Step 2: Setting the double protection low
voltage value, the voltage value can be
between 0.1V ~999.9V.

Step 3: Setting the double protection have
voltage value, the voltage value can be
between 10V ~999.9V.

Step 4: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the mode,
modified voltage value and delayed time.

The operational processes of double protection setting

Three sections phase overcurrent

Normal overcurrent

Select Ph.OC menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the overcurrent protection
current value, the current value can be
between 1A ~ 6000A.

Step 2: Setting the overcurrent delay time, the
delay time can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of simple overcurrent protection setting

Note: Here is a three-stage overcurrent protection period, the use of the other two
are the same.
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Sensitive earth fault

Select SEF menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the SEF protection current
value, the SEF current value can be between
0.1A ~ 999.9A.

Step 2: Setting the SEF delay time, the delay
time can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of SEF protection setting
Cold Load

Select Cold Load menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the cold load protection
current value, the current value can be
between 1A ~ 6000A.

Step 2: Setting the cold load delay time, the
delay time can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to modified
current value and delayed time.

The operational processes of cold load protection setting

Automatic reclosing (Reclose)

Select Reclose menu option press “Enter” key to enter, operational processes
as shown below:
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Step 1: Choose the reclosing times (0:
Invalid, 1: One, 2: Two, 3: Three, 4: Four).

Step 2: Setting the 1st delay time, the delay
time can be between 0S ~ 99.99S.

Step 3: Setting the 2nd delay time, the delay
time can be between 0S ~ 99.99S.

Step 4: Setting the 3rd delay time, the delay
time can be between 0S ~ 99.99S.

Step 5: Setting the 4th delay time, the delay
time can be between 0S ~ 99.99S.

Step 6: Setting the reclosing reset time, the
reset time can be between 1.25~ 180.0S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
mode and modified delayed time/reset time.

The operational processes of automatic reclosing setting

Reclosing acceleration (Recl.ACC)

Select Recl.ACC menu

option press “Enter” key to enter, operational processes

as shown below:

Step 1: Setting the Recl.ACC protection current
value, the current value can be between 1A ~
6000A.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of reclosing acceleration protection setting

Manual closing acceleration (Manu.ACC)

Select Manu.ACC menu

option press “Enter” key to enter, operational

processes as shown below:
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Step 1: Setting the Manu.ACC exit time, the
exit time can be between 0.1S ~ 9.99S.

Step 2: Setting the Manu.ACC protection
current value, the current value can be
between 1A ~6000A.

Step 3: Setting the delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of manual acceleration protection setting

Frequency

Select Frequency menu option press “Enter” key to enter, operational
processes as shown below:

Step 1: Setting the low frequency value, the
low frequency value can be between 40.0Hz
~50.0Hz.

Step 2: Setting the high frequency value, the
high frequency value can be between 50.0Hz
~60.0Hz.

Step 3: Setting the delay time, the delay time
can be between 0.2S ~ 20S.

Step 4: Choose the slip lock mode (0: Invalid,
1: Trip).

Step 5: Setting the slip value, the slip value
can be between 0.3 ~ 40.

Step 6: Choose the low volt. lock mode (0:
Invalid, 1: Trip).

Step 7: Setting the low volt. value, the low
volt. value can be between 10V ~ 110V.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
mode, modified value and delayed time.

The operational processes of Frequency protection setting
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Prepaid (Optional features)

Select Prepaid menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press the [+] and [-] keys to switch the
delayed time.

The operational processes of Prepaid protection setting

4.8 Save parameter

After setting, press “"ESC” key to exit, if modified below figure will show. If you need
to save press “Enter” key and input password, otherwise press “"ESC" key.

4.9 Parameter set

14

Press the EDIT — Para, enter the “parameter set”.

Set the communication parameter

communication set process

If you want to open the communication, you can set "Comm1.status” to "1”, set
“Comm1.address” to 001 and set “comn1.baud” to 09600 so the communication is
run. “Comm1.address” is the address of the device, it used to distinguish the
controller, when more than one controller need communication.
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Password set

The device initial password is “0099”,
the password for the user to modify
from the “0000” ~ “9999”, when revised
press “Enter” key to confirm, enter the
password before the modification.

CT, CTO rate set

CT rate is the three phase current rate.
The value of CT ratio is equal to the
primary side current value divided by
the secondary side current value.

CTO rate is the real zero sequence
current rate. The value of CTO ratio is
equal to the primary side current value
divided by the secondary side current
value.

Note:
1 Different current transformer, CT ratio becomes different.
2 Different current transformer, CTO ratio becomes different.

Close and trip pulse time set

“Close pulse time” is the discharge time for close coil. “Trip pulse time” is the
discharge time for trip coil.

Note: Please do not modify the trip and close pulse time, if in doubt, please consult
ROCKWELL ELECTRIC.

4.10 Calibration

Select the Edit submenu in “Adj.”, press “Enter” key to enter into the password
screen, enter the correct password to enter the “Adj.” submenu, press the [+] and [-]
keys to correct the value of current and voltage.

Note: All voltage and current values in the factory have been corrected before.
Please do not change the parameter values  which, if in doubt please consult
ROCKWELL ELECTRIC, Inc..
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4.11 Clear report

Select the Edit submenu in “Clr”, press “Enter” key to enter, as shown below:

Select "1”: Clear the trip report.
Select "2"”: Clear the alarm report.
Select "3": Clear the SOE report.
Select "4": Clear the count report.

Select "5”: Clear the all report (include trip
record, alarm record, SOE record and count
record) .

4.12 Factory setting

The Factory menu is set by ROCKWELL before leaving the factory, please don't
operate it unless we guide you to do.

4.13 View relay and setting

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Relay” option to press “Enter” key to enter the “Relay” submenu, you can

view all the protection is enabled or disabled, select the option press “Enter”
key to enter the value you can view each protection, press the arrow keys to switch
screens.
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4.14 View SOE

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select “"RPT” option press “Enter” key to enter the "RPT” submenu, you can view the
SOE record events, recording events include: trip signal, alarm signal, telemetry
signal (circuit breaker status, whether the manual or remote operation, fault trip,
time and date, etc.) and count signal (the count of trip).

4.14 View input signal

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Input” option press “Enter” key to enter the “Input” submenu, you can
view the state of input signal.
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5.1 RF remote controller
Function of each key
A:Close
B:Trip
C:Unlock
D:Reset

Note:

1. In order to prevent misuse, press the unlock button for 3 seconds, before
execution of the closing operation.

2. The effective distance of RF remote controller is 30 meters.

5.2 Features and the use of external sockets and switches

AC power switch Backup switch Activation button

Note: Before using the controller, ensure that the battery charge enough for 12
hours.

1. The AC power switch is for protecting the Auxiliary PT (Or utility incomer), and the
BACKUP switch is for charging batteries.
2. After charging the batteries, turn off the power switch to protect the batteries for

storage.
3. Activation button is not allowed for pressing last long time, or permanent damage
of battery under-voltage may result.
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5.3 The main secondary component parts

Cable plug, connect the controller and Cable plug, connect the controller to
circuit breakers. offer the power.

Note: For security norms, Surge protector has to be grounded (green line) to the
earth.

5.4 Battery

® RWK-2RC stand-by battery adopts two 7AH lead-acid free of maintenance
batteries, the average battery life exceeds 3 years.

® Please replace the storage battery in time when the storage battery exceeds its
usage life. Replace method as following: firstly push the stand-by power supply
switch to trip position, and pull out the connection cable simultaneously, rotate
the support bolt away, replace the used battery with new battery. Then recover
the device to the original status according to the contrary sequence. Please deal
with the used battery properly in order not to pollute the environment.
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Danger: The dangerous voltage with the device maybe result in the permanent
damage of equipment or personnel casualty during installing RWK-2RC. These
voltages mainly distributes at terminal bar of device and circuits of AC current input,
AC voltage input, digital input, IGBT output and operation power supply., etc. This
device’s installation, debugging and maintenance can only be operated by technical
staff who has been authorized and trained strictly.

6.1 Installation
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Installation of Box Body

® Please fasten it upon support shelf with matched M10 x 20 stainless bolts during
installing the product. (Support shelf is provided by user, please point it out if
needed to be provided by manufacturer)

® As shown above, place it up side. Don't place it up side down or in slope.

6.2 Maintenance

® If the device is not used, it should be kept in dry and ventilated places indoors,
and charged once every three months, the charging time should be more than
24 hours. Before the device is used, the charging time should not be less than
24 hours. Replace the storage battery each three years.

® This device has storage battery management module, which will automatically
cut off the storage battery output circuit when the storage battery voltage is on
the low side. You should check the storage battery each year, please replace the
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storage battery immediately when single storage battery voltage id lower than

DC12vV.

® Please firstly make sure the first system is power off before the device is
maintained, forbid inserting or pulling out aeronautical connector under power,

thus avoid CT short circuit happening.

6.3 Parts Attached with the Device

Name Quantity  Collocation
Box door key 2 Standard
User Manual 1 Standard
Inspection report 1 Standard
SElEEEe 1 Selectable

telecontroller

Communication

Interface 1 Selectable

Control Cable 2 Standard
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Usage or Description
Open the box

Please read it carefully before
use the device, RWK-2RC wiring
diagram is attached.

Factory inspection report

Telecontrol the close and trip of
switch within 30 meters

RS485/USB converter or
RS485/RS232 converter

20 cords (6 meters)



7.1 Decommission

Shut-down Power Supply

Shut-down Device Power Supply: Turn off external power supply switch of the device.
Disconnect All Power Cables

Disconnect all power cables connected to the device.

Danger: Before disconnecting all power cables connected to the device power
module, it must confirm that the external power switch is turned off to avoid danger.

Danger: Disconnecting all power cables connected to the device alternating current
module, it must confirm that the equipment corresponding to input alternating
component has stopped operation to avoid danger.

Dismantle from Display Cabinet

When the above steps are completed, loosen the fix screws and dismantle the device
from the display cabinet.

Danger: When neighboring equipment is in operation, it must strictly confirm the
safety distance between the dismantled device and other device in operation and
unskilled professional shall take particular caution.

7.2 Disposal

When dispose decommissioned device, please follow relevant regulations of the
country where the product is used for the disposal of scrapped electronic products.

Caution: It must strictly adhere to relevant regulations of the country where the
product is used for the disposal of scrapped electronic products.
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Attachmentl: Device Typical wiring Diagram
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